Drone
Manual Version 1.5
Drone Collector User Manual

Introduction ............................................................................. 3
Registration Code ..................................................................... 3
Opening a Project File ............................................................... 3
Placing a Dynamic Access Point .............................................. 4
Start Survey ............................................................................. 4
Walk/Drive Path ........................................................................ 5
Complete Survey ...................................................................... 5
Information Screen .................................................................... 5
Delete a Point ........................................................................... 6
Bottom Menu ............................................................................ 6
Scroll Bars ................................................................................ 6
Joystick ..................................................................................... 6
Surveying Tips .......................................................................... 7
GPS Information Bar .............................................................. 7

Drone Projector User Manual (iPAQ version)

Introduction ............................................................................. 8
Creating a Projection File ......................................................... 8
Opening an Existing Projection File ......................................... 8
Enter Projection Points ............................................................ 9
Save Projection ......................................................................... 9
Point List .................................................................................. 10
Delete Point ............................................................................. 11
Bottom Menu ............................................................................ 11
Scroll Bars ................................................................................ 12
GPS Information Bar .............................................................. 12

BVS Projector User Manual (PC version)

Getting started with the BVS Projector .................................. 14
Opening a Map ......................................................................... 14
Converting a GEOTIFF File to a CPF or DPF File .................. 14
Saving BVS Projector Workspace ........................................... 15
Opening an Existing Project .................................................... 15
Opening a CPF Project ............................................................. 15
Opening a DPF Project ............................................................. 15
Select a Map to Show ............................................................. 16
Save Current View as a Bitmap .............................................. 16
Printing .................................................................................... 16
Projection Light ......................................................................... 16
Input Format Selection ............................................................ 17
Output a Geo-Coded Map ....................................................... 18
Output Part of a Geo-Coded Map ............................................ 19
Control Buttons in the Toolbar .............................................. 19
Measure Distance ..................................................................... 19
Input Points ............................................................................... 20
Procedure for Creating BVS GPS Projection File .................. 21

Drone Analyzer User Manual

Getting started with the Drone Analyzer .................................. 22
Saving a Drone Site Project File .............................................. 24
Opening an Existing Drone Site Project ................................. 25
Metric Selection ....................................................................... 25
Measurement Information ....................................................... 25
AP Sorting and Selection for Graphing ................................. 26
Range Control ......................................................................... 26
Color Selection ....................................................................... 26
INTRODUCTION

The Drone Collector runs on the HP iPAQ PocketPC that is connected to a BVS YellowJacket Plus system. The Collector allows you to import a GPS projection file that was created using Drone Projector. You then use this file to walk/drive around an outdoor site and collect survey points. These points create a data file of information on your WiFi network.

The information is then saved back to a collection file for use with the Drone Analyzer program on the PC. You can also zoom in and out on points, delete existing points, pull up survey information on any point, and scroll throughout the entire site by use of the stylus.

REGISTRATION CODE

The first time that Drone Collector is run, a dialog box will show up asking for the registration code. This code is located on the paperwork you received from the factory. Each unit has its own registration code that is unique to the serial number.

It is very important that the iPAQ is connected to the YellowJacket when running the Drone application. Drone asks the hardware for its serial number. If it is not talking to the hardware, the registration code will not be verified and the application disabled.

OPENING A PROJECTION FILE

The first step in surveying data is opening a projection file created with Drone Projector. Tap on the leftmost icon on the bottom of the application to open an existing projection file. Then the user will be prompted to choose a previously saved collection file (with previously recorded data) or to start a new collection file.
PLACING A DYNAMIC ACCESS POINT

Dynamic access points can be placed on the site to show their location. Drone Analyzer will be able to show these access points as well. To place an access point, press the ‘AP’ icon on the bottom toolbar. A message will appear asking for a tap on the floor plan. Tap on the location of the floor plan where you would like to represent an access point. An icon representing the dynamic access point will now be visible at that location.

START SURVEY

After you have loaded a site into Collector, you are ready to begin surveying. Make sure that the GPS status bar on the top of the screen is green. This signifies that the GPS receiver is locked and will show the correct location.

Tap on the green circle in the toolbar. This will start an initial scan of all WiFi channels. When a scan is finished, a colored circle representing the strongest signal is displayed.

Successive scans occur automatically at a predetermined interval (5-10 seconds).

Tap on the red circle to stop scanning.
WALK/DRIVE PATH

A dashed line will show up between points on the survey. This dashed line represents the walk/drive path for the survey.

COMPLETE SURVEY

When you have covered the entire site with survey points, press the red circle icon on the toolbar. This will stop the data collection. You can now transfer the file back to the PC for use with Drone Analyzer.

INFORMATION SCREEN

Press and hold on any point in the survey with the stylus. This will pull up an information screen for that survey point. This screen shows all of the MAC addresses that were seen during the scan of this point. Information such as channel number, SSID, and RSSI are displayed.

DELETE A POINT

To delete a point from the survey, press and hold on the desired point. Then press the delete button on the information screen.

BOTTOM MENU

There are 9 menu items located in the main menu at the bottom of the screen.

Open a File

This option will prompt for an existing projection file which had been previously created using Drone Projector. It will then prompt for a filename for the collected data.
Save a File
This option will prompt to save the collected data to a filename of your choice.

Start a Scan
This toolbar option will start the scanning process at regular intervals.

Stop a Scan
This toolbar option will stop the scanning process.

Zoom Into the Site
Pressing on this option will increase the magnification of the site by a factor of 2.

Zoom Away from the Site
Pressing on this option will reduce the magnification of the site by a factor of 2.

JPEG Snapshot
This option will take a snapshot of the current screen. You will be prompted to save the snapshot to a JPEG filename (as in digital cameras).

Dynamic Access Point Placement
A message will appear asking for a tap on the floor plan. Tap on the location of the floor plan where you would like to represent an access point. An icon representing the dynamic access point will now be visible at that location.

About Drone Collector
Standard application about box with version and copyright information.

SCROLL BARS
The scroll bars aid in navigating throughout the site.

JOYSTICK
The joystick on the iPAQ can be used to navigate throughout the site. Pressing the joystick dead on the middle results in a survey point at the location of the cursor. Use the left, right, up and down options on the joystick to maneuver around the site.

SURVEYING TIPS
In order for the Drone Analyzer Investigator to be effective, enough points must be taken so that a clear picture of site coverage is given. Obviously, the more points, the better the reporting will be in Analyzer.

GPS INFORMATION BAR
The GPS information bar shows the current date, time, latitude, and longitude being provided by the GPS receiver. The bar is red when the receiver is not locked, green when it is locked and will show the correct position.

INFORMATION BAR

This information bar shows the zoom factor and the total number of scans.

Drone Projector User Manual (iPAQ software)

INTRODUCTION

The Drone Projector runs on the HP iPAQ PocketPC that is connected to a BVS YellowJacket Plus system. The Projector allows you to import an image to combine with GPS information. This will produce a projection file that will assist in placing data points when taking a survey using the Collector application.

The basic idea behind the projection file is to provide the formulas for projecting a point on the globe onto a flat site image.
You can also zoom in and out on points, delete existing points, pull up a list of the projection points, and scroll throughout the entire site by use of the stylus or joystick.

CREATING A PROJECTION FILE

The first step in creating a projection file is to open an image file. Tap on the leftmost icon on the bottom of the application to open an image file. The image will then be compressed and displayed on the screen.

OPENING AN EXISTING PROJECTION FILE

Tap on the second icon on the bottom of the application to open an existing projection file. The image from this file will be displayed and the projection information will be cleared.
ENTER PROJECTION POINTS

After you have loaded an image into Projector, you are ready to begin taking projection points. Make sure that the GPS status bar on the top of the screen is green. This signifies that the GPS receiver is locked and will show the correct location. Drone Projector will not allow the entering of points if the GPS receiver is not locked.

Begin walking/driving around your site. Tap on the portion of the site where you are located. The X and Y coordinates, as well as the GPS latitude and longitude, will be saved. Continue to tap on a variety of locations covering the entire site. This will ensure that there is enough information to create the projection formulas that will be stored in the projection file.

The Projector will notify the user if the points taken did not result in a satisfactory projection solution.

SAVE PROJECTION

When you have finished taking points, choose the third icon in the toolbar. This will save the projection file for later use with Drone Collector.
POINT LIST

Choose the list icon in the toolbar to see the current list of projection points.
FIGURE 5 – Point list

DELETE A POINT
To delete a point from the survey, press and hold on the desired point.

BOTTOM MENU
There are 8 menu items located in the main menu at the bottom of the screen.

Open an Image File
This option will prompt for an image file to use in the creation of a new projection file.

Open an Existing Projection File
This option will prompt for an existing projection file which had been previously created using Drone Projector.

Save a File
This option will prompt to save the projection data to a filename of your choice.

Zoom Into the Site
Pressing on this option will increase the magnification of the site by a factor of 2.

Zoom Away from the Site
Pressing on this option will reduce the magnification of the site by a factor of 2.

Point List

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
<th>Latitude</th>
<th>Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>111</td>
<td>115</td>
<td>40.5472</td>
<td>-74.3799</td>
</tr>
<tr>
<td>159</td>
<td>175</td>
<td>40.5472</td>
<td>-74.3799</td>
</tr>
<tr>
<td>078</td>
<td>227</td>
<td>40.5472</td>
<td>-74.3799</td>
</tr>
<tr>
<td>134</td>
<td>184</td>
<td>40.5472</td>
<td>-74.3799</td>
</tr>
<tr>
<td>104</td>
<td>117</td>
<td>40.5472</td>
<td>-74.3799</td>
</tr>
<tr>
<td>163</td>
<td>143</td>
<td>40.5472</td>
<td>-74.3799</td>
</tr>
</tbody>
</table>

Delete Selected Point
Choose the list icon in the toolbar to see the current list of projection points. The X, Y, Latitude, and Longitude for each point will be displayed.

JPEG Snapshot

This option will take a snapshot of the current screen. You will be prompted to save the snapshot to a JPEG filename (as in digital cameras).

About Drone Projector

Standard application about box with version and copyright information.

SCROLL BARS

The scroll bars aid in navigating throughout the site.

GPS INFORMATION BAR

The GPS information bar shows the current date, time, latitude, and longitude being provided by the GPS receiver. The bar is red when the receiver is not locked, green when it is locked and will show the correct position.

INFORMATION BAR

This information bar shows the zoom factor and the total number of reference points.
BVS Projector User Manual (PC software)

BVS Projector is used to create a geo-coded map for the analysis of the collected data with BVS survey software, such as Forecaster and Drone.

Getting started with BVS Projector
To use the BVS Projector, a GPS unit or GoogleEarth is needed to provide the latitude and longitude of the points in the map. There are two ways to do the projection:

1. Take a GPS unit to the survey area and record latitude and longitude for more than 8 points and also record the location of the measurement points; or
2. Open GoogleEarth. The latitude and longitude for any point can be seen.

Note that the accuracy requirement for latitude and longitude in the projector program is very high. The accuracy threshold is 0.00001° in decimal degree. The points should be spread out in the map to improve the accuracy of projection.

Open a Map
To begin using the BVS Projector, click on the hotkey to load a map, which can be a bmp, dib, emf, gif, ico, jpg, wmf, tif or tiff file. Then the map will be shown on the screen. To open a GEOTIFF file, just select the file and open it.

Converting a GEOTIFF File to a CPF or DPF File
Click on the hotkey to open the GEOTIFF file, select the file and open it. Select “Output Geo-Map” off the File Manu to save it as a coyote projection file (CDF) or a drone projection file (DPF).
Saving BVS Projector Workspace

At anytime after the project has been created it can be saved to a file. The current settings including state of controls and graph (map, bitmap and points) are saved in a project file and can be recalled later. To save a project select Save or Save as... from the File menu or the Hotkey from the Toolbar. If the project has previously been saved the Save option will overwrite the existing file while the Save as... will allow a new file name to be selected.

Opening an Existing Project

To open an existing Project select “Open” from the File menu or the Hotkey from the Toolbar. A dialog box will appear to allow the selection of the project workspace file (*.pws).

Opening a CPF Project

To open a CPF file, select “Open” from the File menu or the Hotkey from the Toolbar. A dialog box will appear, click on the down arrow and then select the “*.cpf”. All the CPF files in the current fold will be shown.

Opening a DPF Project

To open a DPF file, select “Open” from the File menu or the Hotkey from the Toolbar. A dialog box will appear, click on the down arrow and then select the “*.dpf”. All the DPF files in the current fold will be shown.
Select a Map to Show
If a TIF or TIFF file has multiple maps, the button will be enabled. Click on the button will pop up a dialog box to select the map to display.

Saving Current View as a Bitmap
The current view of the map (with the points) can be saved as a bitmap. Select Save as Bitmap... from the File menu.

Printing
The standard Windows printing selections Print, Print Preview and Print Setup are available from the File menu.

Projection Light
A projection light is used to show if the projection is successful. If it is successful, the light is green; if it is failed, the light is red.
**Input Format Selection**

Input format can be selected in the format of decimal degree or Degree::Minute::Second. The default setting is decimal degree. To select the format use the Hotkey located on the top toolbar. Left click on the hotkey and the format selection dialog box appears.

**Projection Light:**
- **Green Light:** Successful Projection
- **Red Light:** Failed Projection

If a decimal degree is selected, the input format will be

If “Degree::Minute::Second” is selected, the input format will be
Output a Geo-Coded Map

After projection light becomes green, a geo-coded map can be output. Select “Output A Geo-Map” from the File menu and then save it as a CPF file or a DPF file. If the projection light is red, the software is unable to output a geo-coded map.
Output Part of a Geo-Coded Map

If the whole map is too large, for example, one geotiff file can cover a state in the United States. If only part of the map is desired to use, please use the button to select the part from the map and then use the “Output A Geo-Map” key to output a CPF file or DPF file.

Control Buttons in the Toolbar

There are several hot keys available to change the zoom of the graph view.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom In Tool" /></td>
<td>Zoom In Tool</td>
<td>After clicking this hot button, the cursor changes to a magnifying glass.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out Tool" /></td>
<td>Zoom Out Tool</td>
<td>After clicking this hot button, the cursor changes to a zoom-out glass.</td>
</tr>
<tr>
<td><img src="image" alt="Fit to Window" /></td>
<td>Fit to Window</td>
<td>Pressing this hot key fits the image to the current size of the graph window.</td>
</tr>
</tbody>
</table>

Double Click on the point will show the latitude and longitude of the point.

Measure Distance

After projection light becomes green, the ruler button is active. As mouse moves on the map, the latitude and longitude are shown. Left click and hold on the graph to start the measurement. As the mouse moves, distance is displayed in the lower right corner of the window.
**Input Points**

After a point with latitude and longitude is set, the software will compute the projection parameters. If the requirement for projection is not met, the projection light will be red. The points, which do not meet the projection requirement, will be shown on a Dialog. For the example shown below, the 6th point does not meet the requirement, where the error threshold is 0.036 second (0.00001 degree). Double click on the 6th point, check if the input latitude and longitude is right.

**Note:** Please spread out the points in the map to get an accurately geo-coded map. If the points are within a small area in the map, it will be difficult to do the projection successfully for the whole map.
Procedure for creating a BVS GPS Projection File

1. Find the area of interest on GoogleEarth.

2. Select Alt-Print Screen to copy the current screen to the clipboard.

2a. Do not close GoogleEarth, you will need it later.

3. Open MS Paint.

4. Choose Edit/Paste. The screen shot is now in Paint.

5. Use the crop tool (dashed rectangle) to select only the satellite image portion of the screenshot.

6. Choose Edit/Copy.

7. Choose File/New. Do not save the current image.

8. Choose Edit/Paste. The satellite portion of the original is now in the new image.

9. Save this image as a bitmap.

10. Open up BVS GPS Projector.

11. Choose File/New and select the bitmap. You will see a red circle in the upper-right hand corner, this tells you the file is not geo-coded as of yet.

12. Choose "Input Options" from the iconic toolbar under the main menu. Set the resulting popup box to "degree:minute:second".

12a. Leave BVS GPS Projector running.

13. Go back to GoogleEarth. You will need the positions of at least 6 points on the map to create a valid projection in BVS Projector.

14. Choose the pushpin icon "Add Placemark".

15. Move the resulting pushpin to your first location. Write down the latitude and longitude of the location.

NOTE: North is positive and South is negative. East is positive and West is negative. This is important when entering degrees in BVS Projector.

16. Go to BVS Projector and click on the 'set points' icon.
17. Click on the same location as you did on GoogleEarth.

18. Enter the latitude and longitude that you wrote down, keeping in mind to put a negative sign in front of the degrees when needed.

19. The point will be numerically marked.

20. If a popup box stating that the projection is now valid appears, proceed to step 21. A green circle would now appear in the upper right corner. If not, repeat steps 14-20 until a valid projection is obtained.

21. Save the resulting projection in BVS GPS Projector as a GEO-coded map.
Introduction
Drone PC software for your laptop or desktop is all contained on the included CD-ROM. Insert this CD-ROM into your PC and you will be prompted to install the Projector and Collector.

Drone Analyzer is the analysis component of the Yellow Jacket Drone software package for Wireless Local Area Networks (WLAN). It provides analysis of coverage, interference, reliability, channel reuse and more.

Getting started with Drone Analyzer
Drone Analyzer uses a geo-coded map from the Drone Projector and data recorded with the Drone Collector.

Drone Projector generates a Drone Projection File (*.dpf) that contains the map of the survey.
Drone Collector produces a Drone Site Survey file (*.dsd) that contains the collected data with the use of the YellowJacket.

The Drone Analyzer is project based. To begin using the Drone Analyzer a Drone Projection file must first be generated. Click on the hotkey located in the toolbar near the top of the screen. The Drone Projection File dialog box then appears. Open the Drone Projection (map) you wish to use.
The Drone Collector files must then be loaded to create a project. The Drone Analyzer can process multiple survey data files. To create a new project select New Project from the File menu.

The Drone Site Survey file selection dialog then appears.

In the Drone Site Survey file selection dialog press the “Select” button and browse for the *.dsd files you wish to work with.
More files can be selected by clicking on the “Add” button. If you wish to use two or more files that you have saved, you can merge the file by clicking on the “Merge File” box. If a file is added in by mistake check the box before the file and then press the “Delete” button.

Note that the “Merge File” means merging the data in the files to process them together. It does not mean that you are merging the multiple files into one file.

Saving a Drone Site Project File
At anytime after a project has been created, it can be saved to a file. The current settings including state of controls and graph (map, bitmap and analysis) are saved in a project file and can be recalled later. To save a project, select Save or Save as… from the File menu.

If the project has previously been saved the Save option will overwrite the existing file while the Save as… will allow a new file name to be selected.

Opening an Existing Drone Site Project
To open an existing Drone Site Project select Open Existing Project from the File menu. A dialog box will appear to allow the selection of the project file (*.dws).
The Drone Analyzer screen is displayed in two sections.

The left pane of the display contains the Control Window used for Measurement Information, Reliability Analysis and AP Sorting and Selection.

The right pane contains the map from the Drone Projector.

**Metric Selection**

Metric information can be displayed in feet or meters. The default setting is feet. To select the metric use the Hotkey located on the top toolbar. Left click on the hotkey and the metric selection dialog box appears.

**Measurement Information**

Click on the “Measurement Information” button and the information about the coverage area will be shown. These values cannot be changed by the user. If no AP is selected it shows the location for all of the measurements. If one or more AP(s) is selected it shows the ranges of the coverage area surrounding that AP(s). With a map or Drone Projection file it shows the ranges in feet or meters. Without a map it shows the ranges in latitude and longitude.
AP Sorting & Selection for Graphing
Select the Access Points or group of Access Points you wish to work with in the control window under “AP Sorting & Selection”. The AP Selection tool contains a list of all AP(s) that are present in the Site Survey file. Checking the box next to the MAC address includes the AP(s) in the analysis. The AP(s) can be sorted and grouped by SSID or by Channel using the radio buttons at the top of the window.

Range Control
This feature allows the user to control how the signal strength is represented using a graph. The two sliders set the minimum and maximum values for the graphing range.

Color Selection
The color indicator between the MAC address and the check box has two functions:

One is to select the color used to graph signal strength from that AP(s). To change the color for a selected AP(s) right click on the color indicator. A color selection dialog box will appear.

The other is to select how APs are grouped for analysis. By clicking on the space between the check box and the group label (SSID or Channel) the user will be able to choose how the AP(s) are grouped. By left clicking on the indicator the user will be able to toggle between individual mode and combined mode. After checking the AP, the RF coverage of that AP will be shown if it is not in the Reliability Analysis mode. If it is in the Reliability mode the area with certain reliability is shown. Reliability
Analysis is explained in the following section. There are four conditions the user has to choose from as shown in the following table:

<table>
<thead>
<tr>
<th>Example Grouping Description</th>
<th>Example</th>
<th>Grouping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual</td>
<td>SSID: &quot;Wireless&quot;</td>
<td>Individual</td>
<td>Each selected AP is graphed in its own color indicated by the color of the star</td>
</tr>
<tr>
<td>Group Selection By SSID</td>
<td>00-40-33-AP-F2-C1, Chan: 1</td>
<td>Group Selection By SSID</td>
<td>The best coverage for each SSID is shown using the APs selected</td>
</tr>
<tr>
<td>Group Selection By Channel</td>
<td>00-40-33-AP-F1-C5-A3, Chan: 10</td>
<td>Group Selection By Channel</td>
<td>The best coverage for each channel is shown using the APs selected</td>
</tr>
<tr>
<td>Combined Selection</td>
<td>SSID: &quot;Wireless&quot;</td>
<td>Combined Selection</td>
<td>The coverage of the APs selected is combined and graphed in a single color.</td>
</tr>
</tbody>
</table>

Setting AP's Location

When an AP is selected individually, its location and propagation parameters are shown in the control window. It can set/change the AP's location by inputting/changing the X/Y (meter or feet) or Lat/Lon (degree) values and then clicking the button. However, if the location results in wrong propagation parameters, the AP will not be moved to the new location.
Reliability Analysis

Reliability Analysis shows the Radius, Boundary Reliability, Cell Reliability and Power Threshold of the AP(s). This feature allows the user to input numbers into the program and then calculate the performance of the AP(s) along with providing a visual of the coverage area on the map. AP(s) selection for Reliability Analysis is performed with the AP Selection List.

After selecting the AP(s) from the AP Selection List, use the buttons in the control pane to calculate Reliability Analysis. To do single AP analysis, select "Single Analysis" and the selected AP is analyzed. If "Group Analysis" is selected then all the selected AP’s will be analyzed with the same input data.

Click on the “Reliability Analysis” button and enter numbers for the Power Threshold and Radius. Click and the Boundary Reliability and Cell Reliability for this AP is calculated. The coverage of the last selected AP with the radius is shown as a circle in the view window. The reliability represents the probability that the received signal's strength is larger than the threshold value that you entered. The Boundary Reliability represents the probability of the signal strength at the boundary of the circle. The Cell Reliability represents the probability of the signal strength in the highlighted area. On the other hand if Power Threshold and Boundary Reliability are known click and the Radius and Cell Reliability will be calculated and displayed. An example is shown below.

Note: If the “Reliability Analysis” is open, then the software is set to this mode. To see the coverage of the selected AP(s) click the “Reliability Analysis” again to close this mode.

Buttons in the Control Window

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show/Hide Walk/Drive Path" /></td>
<td>Show/Hide Walk/Drive Path</td>
</tr>
<tr>
<td><img src="image" alt="Change the Width of Walk/Drive Path" /></td>
<td>Change the Width of Walk/Drive Path</td>
</tr>
</tbody>
</table>
Show/Hide Points without Enough Satellites to Fix (black dots)

Show/Hide AP Markers

Change the Metric of Grid (X/Y <-> Lon/Lat)

Show/Hide Grid Lines in X (Lon) Direction

Show/Hide Grid Lines in Y (Lat) Direction

Change the Number of Lines in the Grid

**Resolution Control**

[Resolution Control along X/Longitude direction]

[Resolution Control along Y/Latitude direction]

Use the “R” button to set the default resolution

Use these sliders to change the values

**The resolution control shows the size of the points calculated. Setting the control for larger points will reduce the calculation time and decrease the resolution. Typically this control is set to speed up calculations while setting up graphs. The button resets the control to a reasonable default setting.**

**Plot the Coverage**

[Plot Coverage Graph Button]

The detailed analysis can be obtained by pressing the “Plot Coverage” button. The signal strength of the number of APs (N) in the coverage area can be shown by clicking the “Signal Power” button.

**Draw Contours**

To view the contours of the signal strength, signal-to-noise ratio and number of APs in the coverage area, click the contour button and the legend can be viewed by clicking Hotkey.

The range of the power (or number of APs) is shown in the following range control diagram. Move the sliders on the range control by clicking and holding the sliders to the desired value and the contours for the two values will be displayed in the graph window.
Buttons Controlling the View (On the Toolbar)

There are several hot buttons available to control the graph view.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New Data Files</td>
<td>Input data files (*.dsd) to start a project</td>
</tr>
<tr>
<td></td>
<td>Map</td>
<td>Input a projection file (*.dpf)</td>
</tr>
<tr>
<td></td>
<td>Show Map</td>
<td>Show/Hide the map</td>
</tr>
<tr>
<td></td>
<td>Metric</td>
<td>Select the metric to use (Feet or Meter)</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Open an existing project</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Save current project</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Print current view</td>
</tr>
<tr>
<td></td>
<td>Show Direction</td>
<td>Show the direction of the map</td>
</tr>
<tr>
<td></td>
<td>Information Window</td>
<td>Show the coverage information where mouse hovers</td>
</tr>
<tr>
<td></td>
<td>Legend Window</td>
<td>Show legends for the graph</td>
</tr>
<tr>
<td></td>
<td>Move AP</td>
<td>Move AP on the map</td>
</tr>
<tr>
<td></td>
<td>“Zoom In” Tool</td>
<td>After clicking this hot button, the cursor changes to a magnifying glass.</td>
</tr>
<tr>
<td></td>
<td>“Zoom Out” Tool</td>
<td>After clicking this hot button, the cursor changes to a zoom-out glass.</td>
</tr>
<tr>
<td></td>
<td>Fit to Window</td>
<td>Pressing this hot key fits the image to the</td>
</tr>
</tbody>
</table>
### Changing AP Icons

Right click on the AP, a dialog with all icons is shown. Select the desired one and then click the “OK” button.

![AP Icon Options](image)

### Moving Access Points

To move access points, click the hotkey, left click at the center of the AP icon, hold on the graph and move it to the correct location.

### Measuring Distances

Distance measurements can be made on a graph by using the ruler tool. To measure distances use the hotkey. Left click and hold on the graph to start the measurement. By releasing the button the distance is displayed by a distance dialog box.

![Ruler](image)
**Saving Coverage Graph**
The current coverage graph can be saved as a bitmap. Select Save Graph Image... from the File menu.

**Table View**
To view the data point in tabular form select Table Window from the Window menu.

Here is an example of a table view.
where

Lon: Longitude;
Lat: Latitude;
GPS: 3D – 3D fix, 2D – 2D fix, 0 – No fix;
RSSI: received signal strength indicator;
CH: Channel number;
MAC: media access control address;
SSID: Service Set Identifier.

To save the table in a form that can be used by spreadsheet applications and other programs select Save Table as... from the File menu.
The save table options dialog then appears.

The output is an ASCII file that can be customized for easier conversion to a specific program.

**Printing**
The standard Windows printing selections Print, Print Preview and Print Setup are available from the File menu.
KML Report

Keyhole Markup Language (KML) files can be opened by Google Earth™ and the current view will be shown on top of GoogleEarth. If no projection files (*.dpf) exist the Drone software can generate a KML file automatically to plot the graph on top of the map of GoogleEarth. To use this feature, use the Hotkey. If the map is shown on the graph, uncheck the Hotkey to enable the KML Hotkey. Select a file name to store the file when the dialog box appears. After creating a KML file right click on the file and select "GoogleEarth" to open it. Pull down the scroll button at "Places" to the bottom and check the box before "Drone RF Coverage", the view will be shown on top of GoogleEarth and the transparency can also be adjusted by the slider control underneath. It can also be saved in "My Places".
HTML Report

HyperText Markup Language (HTML) files can be opened by Internet Explorer and can contain formatted text and graphics. Drone Analyzer can create a HTML report that has the information about the data survey files, the selected APs, the coverage of signal power and number of APs per location.

To use this feature select Hotkey. Select a file name to store the file when the dialog box appears. A dialog box for HTML report options will be shown. If no detailed analysis is carried the button “show contour of signal strength” and “show contour of # of APs” will be disabled.

If “Show Selected Files” is checked a message box will appear asking if the selected files are to be displayed in the report. If “No” is selected then all the files will be displayed in the report.

Then a dialog appears to allow for comments for the selected file. Enter the comments for the different files by clicking the “Prev” or “Next” buttons. After entering the comments for all the files then click “OK”. All comments will be stored and displayed in the report.
If “Show AP’s Information” is checked a message box will appear asking if selected APs are shown in the report. If “No” is selected then all of the APs will be displayed in the report.

Then a dialog box appears to take the parameters and notes for the selected AP. Enter the parameters and notes for the different AP’s by clicking the “Prev” or “Next” buttons. After entering the notes for all of the AP’s click “OK”. All notes will be saved and displayed in the report.
Please input the information for this AP

1 out of 4 APs

MAC: 00-0F-3D-DF-EE-3F
SSID: Clarion Hotel 6

Transmission Power (dBm): -20
Antenna Gain: 3 dBi
Antenna Height (ft): 3
Direction (Deg): 0

Notes for this AP:
This AP is inside the building of Hotel Clarion.
Drone Site Survey Example

Here is an RF coverage analysis for the Hotel Clarion as investigated with Drone.

1. Set Up A Projection File:
   
   Step 1: Obtain a Bitmap from a Survey area from maps.google.com (or other resources) by using “print screen” button. Type the address and then the map is displayed. Select Hybrid. Use the “Paint” program to save it as a bitmap file and then load it into the iPAQ.
   
   Step 2: Take the iPAQ with the YellowJacket plus (with GPS antenna) to the survey area. Open the “Drone Program” and open the bitmap file. Wait until GPS is locked (status bar goes from red to green).
   
   Step 3: Tap on the iPAQ screen as you move from location to another.
   
   Step 4: Keep tapping on the screen in different locations until the message indicating that you are geo-coded appears then save the file as “bigmap.dpf”.

2. Accumulate A Data Collection File:

   Step 1: Check the battery status of iPAQ and YellowJacket Plus. Make sure both the WLAN and GPS antennas are installed.
   
   Step 2: Open a Projection File and wait until the GPS is locked (status bar goes from red to green).
   
   Step 3: Press the “Record” button (red button in bottom toolbar) and the survey is started.
   
   Step 4: When done with the survey press the “Stop” button (black button in bottom toolbar) and save the file. If you do not press the “Stop” button the unit will keep recording until the batteries are depleted. If more measurement points are required another survey can be taken and then use the Drone analyzer to process the two files jointly.

3. Analyze the Data with Drone Analyzer:

   Here we put one projection file “bigmap.dpf” and two data collection files “clarion2.dsd” and “clarion5.dsd” under the folder “Example”.

   Mode 1: Using the Projection File
   
   Step 1: Load the DPF file.
   
   Step 2: Select the data collection file “Clarion2.dsd” and “Clarion5.dsd”.
   
   Step 3: The walk/drive paths are shown. To see the ranges of walk/drive path click “Measurement Information”.
   
   Step 4: Select all the APs with SSID “Clarion” including “Clarion Hotel 6”, “Clarion 4”, “Clarion Hotel 2” and “Clarion Hotel 5”. The APs will be shown on this image. If the APs are selected individually and the measurement points for the APs meet the minimum required points surrounding the APs, the APs’ locations will be displayed.
Step 5: By using the “Binocular Button” the detailed information about signal strength and AP’s information can be seen by scrolling the mouse over the map.
Step 6: Reliability Analysis. Click on the “Reliability Analysis” button. Select Group Analysis. Then input a threshold of -85 dBm and a Bn. Reliability of 0.80 (boundary reliability). Click “<” and a group of circles are shown in the map which represent the area where the signal has 80% probability that its strength is larger than -80dBm at the boundary. The area has a reliability of 83% because the area close to the AP has a stronger signal than the boundary. Similarly, the radius can be entered and then click “>”, and the reliability will be displayed.

Step 7: To see detailed coverage information press the “Plot Coverage” button and then click on the button and the contour of the signal strength is shown on the map. With the
binocular (information window) button the information of the coverage for any point in the map can be viewed.

Step 8: An HTML report for this study is shown in Appendix II.

Mode 2: Not Using The Projection File

Step 1: Select the data collection file “Clarion2.dsd” and “Clarion5.dsd”.
Step 2: The walk/drive paths are shown. To see the walk/drive path on GoogleEarth click on the KML button to generate a KML report. Save the file as “Example_Clarion.KML”. Note that the bitmap is saved in the folder “Example_Clarion”.

43
Step 3: Use GoogleEarth to open “Example_Clarion.kml”.

Click KML Button to generate a KML report.
Step 4: Check the box before “Drone RF Coverage”. The walk/drive path is displayed on GoogleEarth™.
Step 5: Similarly, all of the pictures displayed in Drone Analyzer can be shown on top of GoogleEarth by generating KML files. The following is an example for the coverage of APs at the Clarion Hotel.
Appendix II. HTML Report

A complete HTML report consists of 6 parts:
1. Information of Survey Files.
2. Information of APs.
3. Walk/Drive path.
4. Coverage of Selected APs.
5. Contour analysis of signal power of selected APs.
6. Contour analysis of the number of APs for the survey area.

Appendix Fig1-5 shows the different parts of the report. An example of a HTML report (HTML_Report_Example.html) is shown in the “Example” folder.

Fig. 1. Survey file information and APs’ information.
Walk/Drive Path and Access Point Location

Fig. 2. Walk/Drive path.

Coverage of Access Points

Fig. 3. Coverage of Selected APs.
Fig. 4. Contour analysis of signal strength for the Clarion Hotel.
Number of APs per location.

Fig. 5. Contour analysis of the number of APs (AP overlay) for the survey area (Clarion Hotel).